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Introduction 

Toutes les institutions publiques ou privés dans lesquelles au moins une personne 

exerce un mandat public pour lequel une rémunération est accordée ou prévue, sont 

tenues de s'inscrire auprès de l'INASTI, ceci dans les 3 mois du fait qui les soumet à la 

loi du 13 juli 2005. Il s'agit d'une inscription unique. Elles doivent aussi adresser 

annuellement pour le 1 juillet une déclaration. La déclaration peut à présent être 

également introduite par un prestataire de services ou par un secrétariat social mandaté 

par votre organisme. 

Vous pouvez vous inscrire et faire la déclaration via l’application protégée PMP-online. 

PMP-online est accessible de deux manières différentes: 

• Via le site web de l'INASTI 

• Via le portal de la Sécurité sociale 

Pour avoir accès à cette application, il vous faut un nom d’utilisateur et un mot de passe. 

Pour plus de détails concernant la réglementation relative aux mandats publics, vous 

pouvez consulter le site web de l’INASTI à la page Mandats publics.
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Si vous ne trouvez pas la réponse à votre question sur le site web de l’INASTI, vous 

pouvez prendre contact avec l’INASTI : 

Helpdesk Eranova pour des problèmes techniques (7.00h à 20.00h): 

• Par téléphone: 02 511 51 51 (option 5) 

• Par courriel: contactcenter@eranova.fgov.be 

Helpdesk Informatique (7.30h à 17.00h): 02 546 40 00 

Service responsable: 

• Par courriel: pmp@rsvz-inasti.fgov.be 

• Par téléphone aux numéros suivants: 

o francophones: 

02 546 43 01 

02 546 42 45 

02 546 43 25 

o néerlandophones: 

02 546 42 24 

02 546 42 40 

02 546 42 79 

 

Abréviations utilisées 

AR = Arrêté royal 

M.B. = Moniteur belge 

N = un chiffre 

Par exemple: NNNN.NNN.NNN = 1234.567.890 

j = jour 

m = mois 
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Procédure pour avoir accès à l’application protégée 

PMP-online est une application protégée. Pour avoir accès à cette application, il vous 

faut un nom d’utilisateur et un mot de passe. 

A. Vous disposez déjà d’un nom d’utilisateur et d’un mot de passe en tant 
qu’employeur ONSS ou ONSSAPL 

Vous pouvez utiliser ce nom d’utilisateur et ce mot de passe pour avoir accès à 

l’application protégée. 

B. Vous ne disposez pas encore d’un nom d’utilisateur et d’un mot de 
passe en tant qu’employeur 

Vous devez demander un nom d’utilisateur et un mot de passe pour avoir accès à 

l’application protégée. 

Employeurs ONSS 

Vous pouvez demander l’accès à l’application protégée PMP-online au moyen d’un 

formulaire électronique disponible sur le site portail de la sécurité sociale. 

Pour plus d’informations quant à l’accès protégé pour les employeurs ONSS, consultez 

le site portail de la sécurité sociale. 
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Employeurs ONSSAPL 

Demandez votre nom d’utilisateur et votre mot de passe au moyen du “Formulaire R2 : 

Gestion des données du répertoire des employeurs ONSSAPL” (document Word). 

Que faut-il indiquer sur le formulaire ? 

Il faut compléter ce qui suit : 

• Des données concernant votre administration sur la première page  

• “Volet 3” (désignation d’un gestionnaire local) 

• Le volet le plus haut sur la dernière page 

Comment utiliser le formulaire ? 

Vous pouvez utiliser le formulaire de 2 façons différentes: 

Première façon 

1. vous ouvrez le document, 

2. vous le complétez à l'écran, 

3. vous l'imprimez, 

4. vous le signez, 

5. vous l'expédiez par la poste. 

Deuxième façon 

1. vous ouvrez le document, 

2. vous l'imprimez, 

3. vous le complétez, 

4. vous le signez, 

5. vous l'expédiez par la poste. 
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Où envoyer le formulaire ? 

Vous devez envoyer le formulaire à: 

ONSSAPL 

Rue Joseph II 47 

1000 Bruxelles 

Vous trouvez plus d’informations au sujet du rôle et des possibilités du gestionnaire local 

dans le document “Procédure à suivre pour accéder aux applications sécurisées” 

(document .pdf). 

Autres entreprises 

Vous pouvez demander accès à l’application protégée PMP-online à l’aide d’un 

formulaire électronique sur le site portail de la sécurité sociale. 

Pour plus d’informations quant à l’accès protégé pour les employeurs ONSS, consultez 

le site portail de la sécurité sociale. 
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Inscrire votre organisme à l'INASTI 

Lorsque votre institution n'est pas encore inscrite auprès de l'INASTI, l'écran ci-dessous 

apparaît: 

 

Choisissez dans la liste la langue dans laquelle se déroulera la communication avec 

votre organisme. Vous avez le choix entre le français, le néerlandais et l'allemand. 

Cliquez sur le lien "Inscrire" pour inscrire votre organisme à l'INASTI.
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Vous obtenez un écran avec des données concernant votre organisme: 

 

Les données de l'organisme montrées sur l'écran sont les données officielles telles 

qu'elles sont connues par la Banque carrefour des entreprises. 

Cliquez sur le bouton "Confirme l'inscription" pour confirmer votre inscription. 
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Vous obtenez l'écran suivant: 

 

En haut de l'écran, vous trouverez la confirmation de ce que votre inscription a été 

exécutée avec succes, ainsi que la date de votre inscription. Plus bas apparaissent des 

champs relatifs à: 

• Votre organisme; 

• La personne de contact de votre organisme; 

• L’adresse de correspondance de votre organisme. 
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Lorsque vous cliquez sur le bouton "Modifier", un écran apparaît sur lequel vous pouvez 

compléter les informations suivantes: 

• La langue dans laquelle se déroulera la communication avec votre organisme; 

• Le numéro de compte en banque de votre organisme; 

• Des données concernant la personne de contact de votre organisme (le nom, le 

prénom, la fonction, le numéro de téléphone et l’adresse électronique; 

• Des données concernant l'adresse de correspondance de votre organisme (le 

nom, la rue, le numéro, la boîte, le code postal et la commune) 

Attention! Si vous ne devez vous inscrire qu’une seule fois auprès de l’INASTI, il 

vous appartient de faire une déclaration annuelle. Vous pouvez faire la déclaration en 

cliquant sur “Nouvelle déclaration” à la gauche de votre écran. Suivez ensuite les 

instructions sous Nouvelle déclaration – Formulaire “Déclaration mandataires”. 
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Nouvelle déclaration – Formulaire “Déclaration mandataires” 

Le formulaire “Déclaration mandataires” vous permet de faire enregistrer la déclaration 

de vos mandataires publics. La déclaration peut à présent être également introduite par 

un prestataire de services ou par un secrétariat social mandaté par votre organisme. 

Cliquez à la gauche de l’écran sur “Nouvelle déclaration mandataires”. 

 

Eléments du formulaire “Déclaration mandataires” 

Le formulaire se compose des éléments suivants: 

• Un champ dans le titre où vous devez compléter l’année de cotisation pour 

laquelle vous déclarez les mandataires publics; 

• 2 questions auxquelles vous devez répondre par “oui” ou “non”; 

• Le bouton “Déclaration mandataires”.
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A. Remplissez l’année de cotisation pour laquelle vous déclarez les 
mandataires publics 

Remplissez en haut de la case à compléter dans le titre, l’année de cotisation pour 

laquelle vous déclarez les mandataires publics. 

B. Répondez par “oui” ou “non” aux 2 questions 

Question 1: Votre organisme a-t-il, au cours de l’année de cotisation déclarée, un ou 

plusieurs mandataires publics pour le(s)quel(s) une rétribution est attribuée ou prévue ?  

Répondez par “oui” ou “non” à la question 1 en indiquant votre choix dans le menu qui 

s’affiche après la question. 

Question 2: Votre organisme avait-il, au cours de l’année précédant l’année de 

cotisation déclarée, un ou plusieurs mandataires publics pour le(s)quel(s) une rétribution 

était attribuée ou prévue ? 

Répondez par “oui” ou “non” à la question 2 en indiquant votre choix dans le menu qui 

s’affiche après la question. 

C. Cliquez sur le bouton “Déclaration mandataires” 

Après avoir répondu aux 2 questions, cliquez sur le bouton “Déclaration mandataires”. 

L’écran que vous obtenez alors dépend des réponses que vous avez données aux 2 

questions. 4 paires de réponses sont possibles : 

• Vous avez répondu “oui” à la question 1 et “oui” à la question 2 ; 

• Vous avez répondu “oui” à la question 1 et “non” à la question 2 ; 

• Vous avez répondu “non” à la question 1 et “oui” à la question 2 ; 

• Vous avez répondu “non” à la question 1 et “non” à la question 2. 

En fonction des réponses que vous avez données, vous obtenez un écran sur lequel 

vous devez indiquer des données de détail concernant les mandataires ou une 

confirmation de votre déclaration.
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Vous avez répondu “oui” à la question 1 et “oui” à la question 2 

Formulaire “Données de détail mandataires” 

Après avoir cliqué sur le bouton “Déclaration mandataires”, vous obtenez le formulaire à 

compléter “Données de détail mandataires”: 

 

 

Sur le formulaire vous trouvez les données suivantes: 

• Les réponses que vous avez données aux 2 questions; 

• Un certain nombre de lignes sur lesquelles vous devez indiquer les données de 

détail des mandataires.
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A. Champs sur le formulaire “Données de détail mandataires” 

Vous devez compléter une ligne pour chaque mandataire. 

Il y a 2 possibilités pour compléter le formulaire "Données de détail mandataires": 

1. Pour chaque mandataire public, vous complétez manuellement une ligne avec 

les données de détail; 

2. Vous utilisez la fonction d'importation. 

Vous trouverez plus d'info sur la fonction d'importation sous Fonction 

d'importation. 

Si vous avez plus de 200 mandataires publics à introduire, vous ne pouvez plus 

compléter les données de détail manuellement. Dans ce cas-là, vous devrez utiliser la 

fonction d'importation. 

P/M* 
Est-ce-que le mandataire public est une personne physique (P) ou une personne morale 

(M)? Choisissez “P” ou “M” dans le menu. 

Numéro 
Le numéro que vous devez remplir ici, dépend du choix que vous avez fait dans le menu 

P/M. 

• Vous avez choisi M dans le menu P/M 

Remplissez le numéro d’entreprise dans le format NNNN.NNN.NNN. 

• Vous avez choisi P dans le menu P/M 

Remplissez le numéro de registre national dans le format NNNNNN.NNN.NN. 
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Numéro d’entreprise 

Si vous ne connaissez pas le numéro d’entreprise de l’organisme, vous pouvez le rechercher sur 

le site web de la Banque carrefour des entreprises. 

Après avoir sélectionné votre langue, l’écran suivant s’affiche: 
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Cliquez dans le haut de l’écran sur “Recherche par mots-clés” ou cliquez sur le lien hypertexte 

“recherche par mots-clés” sous le titre “Mode de recherche”. L’écran suivant s’affiche : 

 

Remplissez dans le champ à côté de “Introduisez vos mots-clés” le nom de l’organisme et cliquez 

sur “Rechercher des entreprises”. Vous obtenez un tableau dans lequel vous pouvez lire le 

numéro d’entreprise dans la deuxième colonne. 
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Numéro de registre national 

Vous trouverez votre numéro de registre national au recto de votre carte SIS ou, si vous 

l’avez demandé, au dos de votre carte d’identité. 

 

 

 

Nom 
Remplissez le nom du mandataire public que vous déclarez. 

Période du 
Remplissez la date de début de la période pour laquelle vous déclarez le mandataire 

public. 

Période au 
Remplissez la date de fin de la période pour laquelle vous déclarez le mandataire public. 

Rémunération (en euros) 
Remplissez le montant total brut de la rétribution (en euros) que le mandataire a perçue 

ou qui est prévue pour le mandataire pour la période que vous avez indiquée dans 

“Période du” et “Période au”. 

Numéro organisme 
Remplissez le numéro d’entreprise de l’organisme qui a mandaté le mandataire public 

(attention: donc pas le numéro d'organisme de votre propre organisme).
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Nom organisme 
Remplissez le nom de l’organisme qui a mandaté le mandataire public (attention: donc 

pas le nom de votre propre organisme). 

Si toutes les lignes sont complétées et que vous n’avez pas encore déclaré tous les 

mandataires, vous pouvez ajouter des lignes en cliquant sur le bouton “Ajouter des 

lignes”. 

Si vous constatez que vous avez déclaré un mandataire que vous n’auriez pas dû 

déclarer, vous pouvez supprimer la ligne concernée en cliquant sur le bouton 

d’effacement “X” qui suit la ligne. 

B. Boutons sur le formulaire “Données de détail mandataires” 

Bouton “Sauvegarder déclaration” 
Cliquez sur “Sauvegarder déclaration” pour sauvegarder les données que vous avez 

indiquées. 

Attention! Vous devez encore toujours envoyer votre déclaration à l’INASTI. 

Vous pouvez immédiatement envoyer votre déclaration en cliquant, sur l’écran suivant, 

sur le bouton “Envoyer déclaration”. 

Si vous avez sauvegardé votre déclaration et que vous ne souhaitez pas l’envoyer 

immédiatement parce que vous voulez éventuellement l’adapter ou la compléter, vous 

pouvez retourner à la déclaration sauvegardée via “Déclarations ouvertes”.  

Bouton “Annuler déclaration” 
Cliquez sur “Annuler déclaration” pour annuler votre déclaration. Les données que vous 

avez indiquées ne sont pas conservées et ne seront donc pas envoyées à l’INASTI. 

Vous retournez à l’écran avec les données d’identification de votre organisme. 

Bouton "Importer déclaration" 

Cliquez sur "Importer déclaration" pour introduire les données détaillées relatives aux 

mandataires publics toutes en même temps, en une opération. 

Vous trouverez plus d'info sur la fonction d'importation sous Fonction d'importation. 

Bouton "Exporter déclaration" 

Cliquez sur "Exporter déclaration" pour exporter une déclaration existante d'une année 

de cotisation vers le disque dur de votre pc. 

Vous trouverez plus d'info sur la fonction d'exportation sous Fonction d'exportation.
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Ecran de contrôle “Déclaration mandataires” 

Après avoir cliqué sur le bouton “Sauvegarder déclaration”, vous obtenez un écran de 

contrôle: 

 

A. Données sur l’écran de contrôle “Déclaration mandataires” 

Vous trouvez les données suivantes: 

• Les réponses que vous avez données aux 2 questions; 

• Les données de détail que vous avez complétées, pour les mandataires que 

vous déclarez, sur le formulaire “Données de détail mandataires”.
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B. Boutons sur l’écran de contrôle “Déclaration mandataires” 

Bouton “Envoyer déclaration” 
Cliquez sur “Envoyer déclaration” pour confirmer la déclaration de vos mandataires 

publics et l’envoyer à l’INASTI. 

Attention! Si votre déclaration n’est pas encore complète parce que tous vos 

mandataires publics ne sont pas encore indiqués ou parce que vous voulez encore 

apporter des modifications, ne cliquez pas encore sur le bouton “Envoyer 
déclaration”.  

Vous devez alors: 

• Soit cliquer sur le bouton “Modifier déclaration” pour compléter immédiatement 

votre déclaration; 

• Soit quitter l’application et vous reconnecter ultérieurement pour compléter votre 

déclaration via “Déclarations ouvertes”. 

Bouton “Annuler déclaration” 
Cliquez sur “Annuler déclaration” pour annuler la déclaration de vos mandataires 

publics. Votre déclaration n’est pas transmise à l’INASTI. 

Bouton “Modifier déclaration” 
Si vous constatez, en vérifiant les données sur l’écran de contrôle, que vous avez 

commis une erreur en déclarant les mandataires publics ou si vous souhaitez compléter 

votre déclaration, vous pouvez le faire en cliquant sur “Modifier déclaration”.
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Confirmation “Déclaration mandataires” 

Après avoir cliqué sur le bouton “Envoyer déclaration”, vous obtenez l’écran suivant 

avec la confirmation de votre déclaration: 
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Vous trouvez les données suivantes: 

• La date de confirmation de votre déclaration; 

• Des données concernant votre organisme: le numéro d’entreprise, le nom et 

l’adresse; 

• Des données concernant le bénéficiaire: le numéro de compte en banque, le 

nom, la rue et la localité; 

• Les données de paiement: la cotisation calculée, la cotisation à payer et la 

communication structurée qui l’accompagne obligatoirement ; 

• La mention de la date à laquelle le compte de l’INASTI doit être crédité au plus 

tard; 

• Les données de détail concernant les mandataires que vous avez déclarés. 

Si vous souhaitez ouvrir la confirmation de votre déclaration en format PDF, vous 

pouvez cliquer sur le bouton “Déclaration en format PDF”.
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Vous avez répondu “oui” à la question 1 et “non” à la question 2 

Ecran de contrôle “Déclaration mandataires” 

Après avoir cliqué sur le bouton “Déclaration mandataires”, vous obtenez un écran de 

contrôle: 

 

Sur cet écran de contrôle, vous trouvez: 

• Les 2 questions auxquelles vous deviez répondre, ainsi que les réponses que 

vous avez données; 

• Le bouton “Envoyer déclaration” vous permettant de confirmer votre déclaration 

et de la transmettre à l’INASTI; 

• Le bouton “Annuler déclaration” pour annuler votre déclaration. 
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Confirmation “Déclaration mandataires” 

Après avoir cliqué sur le bouton “Envoyer déclaration”, vous obtenez un écran avec la 

confirmation de votre déclaration: 
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Vous trouvez les données suivantes: 

• La date de confirmation de votre déclaration; 

• Des données concernant votre organisme: le numéro d’entreprise, le nom et 

l’adresse; 

• Des données concernant le bénéficiaire: le numéro de compte en banque, le 

nom, la rue et la localité; 

• Des données de paiement : la cotisation calculée et la cotisation à payer. 

La cotisation que vous devez payer est de 0,00 euro. Vous ne devez pas payer 

de cotisation. 

Si vous souhaitez ouvrir la confirmation de votre déclaration en format PDF, vous 

pouvez cliquer sur le bouton “Déclaration en format PDF”.
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Vous avez répondu “non” à la question 1 et “oui” à la question 2 

Formulaire “Données de détail mandataires” 

Après avoir cliqué sur le bouton “Déclaration mandataires”, vous obtenez le formulaire à 

compléter “Données de détail mandataires”: 

 

 

Sur le formulaire vous trouvez les données suivantes: 

• Les réponses que vous avez données aux 2 questions; 

• Un certain nombre de lignes sur lesquelles vous devez indiquer les données de 

détail des mandataires 
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A.  Champs sur le formulaire “Données de détail mandataires” 

Vous devez compléter une ligne pour chaque mandataire. 

Il y a 2 possibilités pour compléter le formulaire "Données de détail mandataires": 

1. Pour chaque mandataire public, vous complétez manuellement une ligne avec 

les données de détail; 

2. Vous utilisez la fonction d'importation. 

Vous trouverez plus d'info sur la fonction d'importation sous Fonction 

d'importation. 

Si vous avez plus de 200 mandataires publics à introduire, vous ne pouvez plus 

compléter les données de détail manuellement. Dans ce cas-là, vous devrez utiliser la 

fonction d'importation. 

P/M* 
Est-ce-que le mandataire public est une personne physique (P) ou une personne morale 

(M)? Choisissez “P” ou “M” dans le menu. 

Numéro 
Le numéro que vous devez remplir ici, dépend du choix que vous avez fait dans le menu 

P/M. 

• Vous avez choisi M dans le menu P/M 

Remplissez le numéro d’entreprise dans le format NNNN.NNN.NNN. 

• Vous avez choisi P dans le menu P/M 

Remplissez le numéro de registre national dans le format NNNNNN.NNN.NN. 
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Numéro d’entreprise 

Si vous ne connaissez pas le numéro d’entreprise de l’organisme, vous pouvez le rechercher sur 

le site web de la Banque carrefour des entreprises. 

Après avoir sélectionné votre langue, l’écran suivant s’affiche: 
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Cliquez dans le haut de l’écran sur “Recherche par mots-clés” ou cliquez sur le lien hypertexte 

“recherche par mots-clés” sous le titre “Mode de recherche”. L’écran suivant s’affiche : 

 

Remplissez dans le champ à côté de “Introduisez vos mots-clés” le nom de l’organisme et cliquez 

sur “Rechercher des entreprises”. Vous obtenez un tableau dans lequel vous pouvez lire le 

numéro d’entreprise dans la deuxième colonne. 
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Numéro de registre national 

Vous trouverez votre numéro de registre national au recto de votre carte SIS ou, si vous 

l’avez demandé, au dos de votre carte d’identité. 

 

 

 

Nom 
Remplissez le nom du mandataire public que vous déclarez. 

Période du 
Remplissez la date de début de la période pour laquelle vous déclarez le mandataire 

public. 

Période au 
Remplissez la date de fin de la période pour laquelle vous déclarez le mandataire public. 

Rémunération (en euros) 
Remplissez le montant total brut de la rétribution (en euros) que le mandataire a perçue 

ou qui est prévue pour le mandataire pour la période que vous avez indiquée dans 

“Période du” et “Période au”. 

Numéro organisme 
Remplissez le numéro d’entreprise de l’organisme qui a mandaté le mandataire public 

(attention: donc pas le numéro d'organisme de votre propre organisme).
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Nom organisme 
Remplissez le nom de l’organisme qui a mandaté le mandataire public (attention: donc 

pas le nom de votre propre organisme). 

Si toutes les lignes sont complétées et que vous n’avez pas encore déclaré tous les 

mandataires, vous pouvez ajouter des lignes en cliquant sur le bouton “Ajouter des 

lignes”. 

Si vous constatez que vous avez déclaré un mandataire que vous n’auriez pas dû 

déclarer, vous pouvez supprimer la ligne concernée en cliquant sur le bouton 

d’effacement “X” qui suit la ligne. 

B. Boutons sur le formulaire “Données de détail mandataires” 

Bouton “Sauvegarder déclaration” 
Cliquez sur “Sauvegarder déclaration” pour sauvegarder les données que vous avez 

indiquées. 

Attention! Vous devez encore toujours envoyer votre déclaration à l’INASTI. 

Vous pouvez immédiatement envoyer votre déclaration en cliquant, sur l’écran suivant, 

sur le bouton “Envoyer déclaration”. 

Si vous avez sauvegardé votre déclaration et que vous ne souhaitez pas l’envoyer 

immédiatement parce que vous voulez éventuellement l’adapter ou la compléter, vous 

pouvez retourner à la déclaration sauvegardée via “Déclarations ouvertes”.  

Bouton “Annuler déclaration” 
Cliquez sur “Annuler déclaration” pour annuler votre déclaration. Les données que vous 

avez indiquées ne sont pas conservées et ne seront donc pas envoyées à l’INASTI. 

Vous retournez à l’écran avec les données d’identification de votre organisme. 

Bouton "Importer déclaration" 

Cliquez sur "Importer déclaration" pour introduire les données détaillées relatives aux 

mandataires publics toutes en même temps, en une opération. 

Vous trouverez plus d'info sur la fonction d'importation sous Fonction d'importation. 

Bouton "Exporter déclaration" 

Cliquez sur "Exporter déclaration" pour exporter une déclaration existante d'une année 

de cotisation vers le disque dur de votre pc. 

Vous trouverez plus d'info sur la fonction d'exportation sous Fonction d'exportation.
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Ecran de contrôle “Déclaration mandataires” 

Après avoir cliqué sur le bouton “Sauvegarder déclaration”, vous obtenez un écran de 

contrôle: 

 

A. Données sur l’écran de contrôle “Déclaration mandataires” 

Vous trouvez les données suivantes: 

• Les réponses que vous avez données aux 2 questions; 

• Les données de détail que vous avez complétées, pour les mandataires que 

vous déclarez, sur le formulaire “Données de détail mandataires”.
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B. Boutons sur l’écran de contrôle “Déclaration mandataires” 

Bouton “Envoyer déclaration” 
Cliquez sur “Envoyer déclaration” pour confirmer la déclaration de vos mandataires 

publics et l’envoyer à l’INASTI. 

Attention! Si votre déclaration n’est pas encore complète parce que tous vos 

mandataires publics ne sont pas encore indiqués ou parce que vous voulez encore 

apporter des modifications, ne cliquez pas encore sur le bouton “Envoyer 
déclaration”.  

Vous devez alors: 

• Soit cliquer sur le bouton “Modifier déclaration” pour compléter immédiatement 

votre déclaration; 

• Soit quitter l’application et vous reconnecter ultérieurement pour compléter votre 

déclaration via “Déclarations ouvertes”. 

Bouton “Annuler déclaration” 
Cliquez sur “Annuler déclaration” pour annuler la déclaration de vos mandataires 

publics. Votre déclaration n’est pas transmise à l’INASTI. 

Bouton “Modifier déclaration” 
Si vous constatez, en vérifiant les données sur l’écran de contrôle, que vous avez 

commis une erreur en déclarant les mandataires publics ou si vous souhaitez compléter 

votre déclaration, vous pouvez le faire en cliquant sur “Modifier déclaration”.
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Confirmation “Déclaration mandataires” 

Après avoir cliqué sur le bouton “Envoyer déclaration”, vous obtenez l’écran suivant 

avec la confirmation de votre déclaration: 
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Vous trouvez les données suivantes: 

• La date de confirmation de votre déclaration; 

• Des données concernant votre organisme: le numéro d’entreprise, le nom et 

l’adresse; 

• Des données concernant le bénéficiaire: le numéro de compte en banque, le 

nom, la rue et la localité; 

• Les données de paiement: la cotisation calculée, la cotisation à payer et la 

communication structurée qui l’accompagne obligatoirement ; 

• La mention de la date à laquelle le compte de l’INASTI doit être crédité au plus 

tard; 

• Les données de détail concernant les mandataires que vous avez déclarés. 

Si vous souhaitez ouvrir la confirmation de votre déclaration en format PDF, vous 

pouvez cliquer sur le bouton “Déclaration en format PDF”. 
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Vous avez répondu “non” à la question 1 et “non” à la 
question 2 

Ecran de contrôle “Déclaration mandataires” 

Après avoir cliqué sur le bouton “Déclaration mandataires”, vous obtenez un écran de 

contrôle: 

 

Vous trouvez sur l’écran de contrôle: 

• Les 2 questions auxquelles vous deviez répondre, ainsi que les réponses que 

vous avez données; 

• Le bouton “Envoyer déclaration” pour confirmer votre déclaration et la 

transmettre à l’INASTI; 

• Le bouton “Annuler déclaration” pour annuler votre déclaration. 

Manuel accompagnant l’application protégée PMP-online 37



Confirmation “Déclaration mandataires” 

Après avoir cliqué sur le bouton “Envoyer déclaration”, vous obtenez un écran avec la 

confirmation de votre déclaration: 
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Vous trouvez les données suivantes: 

• La date de confirmation de votre déclaration; 

• Des données concernant votre organisme: le numéro d’entreprise, le nom et 

l’adresse; 

• Des données concernant le bénéficiaire : le numéro de compte en banque, le 

nom, la rue et la localité; 

• Des données de paiement: la cotisation calculée et la cotisation à payer. 

La cotisation que vous devez payer est de 0,00 euro. Vous ne devez pas payer 

de cotisation. 

Si vous souhaitez ouvrir la confirmation de votre déclaration en format PDF, vous 

pouvez cliquer sur le bouton “Déclaration en format PDF”.
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Déclarations ouvertes mandataires 

Lorsque vous cliquez sur “Déclarations ouvertes”, vous obtenez l’écran suivant: 

 

L’écran montre un aperçu des années de cotisation pour lesquelles des déclarations de 

mandataires sont encore ouvertes. Ces déclarations n’ont pas encore été transmises à 

l’INASTI. 

Cliquez sur une année de cotisation pour consulter, adapter ou compléter les détails de 

la déclaration ouverte pour cette année de cotisation. 

Il y a 2 possibilités pour compléter le formulaire "Données de détail mandataires": 

1. Pour chaque mandataire public, vous complétez manuellement une ligne avec 

les données de détail; 

2. Vous utilisez la fonction d'importation. 

Vous trouverez plus d'info sur la fonction d'importation sous Fonction 

d'importation. 
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Si vous avez plus de 200 mandataires publics à introduire, vous ne pouvez plus 

compléter les données de détail manuellement. Dans ce cas-là, vous devrez utiliser la 

fonction d'importation. 
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Déclarations précédentes mandataires  

Lorsque vous cliquez sur “Déclarations précédentes” à la gauche de l’écran, vous 

obtenez un aperçu de vos déclarations précédentes, qui ont été confirmées et 

transmises à l’INASTI. Les déclarations précédentes sont classées par année de 

cotisation: 

 

Vous trouvez les données suivantes sur chaque ligne: 

Année de cotisation 
Les déclarations sont classées par année de cotisation. En cliquant sur l’année de 

cotisation, vous pouvez consulter la déclaration en format PDF. La déclaration contient 

les données de l’institution, le bénéficiaire et les données de paiement. 

Cotisation calculée  

La colonne “Cotisation calculée” affiche la cotisation qui est le résultat de la dernière 

déclaration de cette année de cotisation. 
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Lorsque vous faites une nouvelle déclaration adaptée pour une année de cotisation, la 

cotisation est recalculée. 

Cotisation à payer 
La colonne “Cotisation à payer” montre le montant de la cotisation payée, ou encore à 

payer, pour l’année de cotisation. 

Date de déclaration 
La colonne “Date de déclaration” montre la date à laquelle la déclarations des 

mandataires publics a été confirmée et transmise à l’INASTI.  

Date limite de paiement  
La colonne “Date limite de paiement” montre la date à laquelle la cotisation devait être 

payée au plus tard. 

Communication structurée  
La colonne “Communication structurée” montre la communication indiquée lors du 

paiement de la cotisation. 

Bouton “Déclaration adaptée” 
Pour une année de cotisation déterminée, vous pouvez faire une nouvelle déclaration 

adaptée après avoir déjà fait la déclaration pour cette année de cotisation et l’avoir 

transmise à l’INASTI. Cliquez à cet effet sur le bouton “Déclaration adaptée”. Vous 

retournez à l’écran “Nouvelle déclaration“. 

Attention! Le délai de prescription est de 5 ans. Si vous voulez faire une nouvelle 

déclaration adaptée pour une année de cotisation déterminée, vous disposez donc de 

5 ans au plus.
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Fonction d'importation 

La fonction d'importation vous permet, en tant qu'organisme, d'introduire les données 

détaillées relatives aux mandataires publics toutes en même temps, en une opération. 

Ainsi vous pouvez charger de données externes sur les mandataires, par exemple des 

données provenant d'un fichier Excel, dans l'application déclaration. 

Attention! Pour pouvoir utiliser la fonction d'importation, le fichier que vous voulez 

charger doit répondre à certaines conventions. 

Vous trouverez plus d'info sur les conventions pour la création d'un fichier d'importation 

sous Conventions pour la création d'un fichier d'importation. 

Vous pouvez utiliser la fonction d'importation dans les cas suivants: 

• Import des données de détail lors de la saisie d'une nouvelle déclaration pour 

une année de cotisation 

• Import des données de détail lors de la modification/suppression d'une 

déclaration ouverte 

• Import des données de détail lors de la modification d'une déclaration précédente 
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Import lors de la saisie d'une nouvelle déclaration pour une 
année de cotisation 

Après avoir cliqué sur "Nouvelle déclaration" à la gauche de l'écran et répondu 2 fois 

"oui" ou "non" et "oui" aux 2 questions, vous obtenez un écran semblable à celui-ci: 
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Suivez les étapes ci-après pour importer les données détaillées relatives aux 

mandataires publics. 

Etape 1: Cliquez sur le bouton "Importer déclaration". Vous obtenez un écran semblable 

à celui-ci: 

 

 

Etape 2: Dans le menu "Première ligne du fichier d'importation", vous avez 2 choix 

possibles: 

• Comprend les données 

Choisissez "Comprend les données" si la première ligne du fichier que vous 

voulez importer ne contient que des données et pas de définitions des champs. 

Vous trouverez plus d'info sur cette choix sous Conventions pour la création d'un 

fichier d'importation. 

• Contient des définitions des champs 

Choisissez "Contient des définitions des champs" si la première ligne du fichier 
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que vous voulez importer contient des définitions des champs. 

Vous trouverez plus d'info sur cette choix sous Conventions pour la création d'un 

fichier d'importation. 

Etape 3: Cliquez sur "Browse". Vous obtenez un écran semblable à celui-ci: 

 

Etape 4: Sélectionnez le fichier que vous voulez importer et cliquez sur "Create". 

Vous obtenez un écran contenant les données du fichier que vous avez importé. 

Maintenant vous pouvez modifier les données de la déclaration ou confirmer la 

déclaration. 

Quand vous cliquez sur "Version imprimable", vous obtenez une version imprimable de 

l'écran. Vous pouvez imprimer les données via votre browser (File > Print). Vous 

obtiendriez la meilleure mise en page en "landscape" (File > Page Setup > dans 

"Orientation", choisissez "Landscape"). 

Remarque: Quand le fichier que vous avez importé contient des erreurs, une liste qui 

mentionne toutes les erreurs apparaît à l'écran. Vous pouvez l'imprimer via votre 

browser (File > Print). 
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Import lors de la modification/suppression d'une déclaration 
ouverte 

Après avoir cliqué sur "Déclarations ouvertes" à la gauche de l'écran et puis sur une 

année de cotisation, vous obtenez un écran avec les données de détail de cette année 

de cotisation: 

 

 

Suivez les étapes ci-après pour importer les données détaillées relatives aux 

mandataires publics. 

Etape 1: Cliquez sur le bouton "Importer déclaration". 

Attention! Tenez compte que les données importées effacent complètement les 

données existantes. 

Suivez maintenant les étapes 2 à 4 décrites plus haut sous Import lors de la saisie d'une 

nouvelle déclaration pour une année de cotisation. 
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Import lors de la modification d'une déclaration précédente 

Après avoir cliqué sur "Déclarations précédentes" à la gauche de l'écran et puis sur le 

bouton "Déclaration adaptée" pour une certaine année de cotisation, vous arrivez sur 

l'écran "Nouvelle déclaration". 

Après avoir répondu 2 fois "oui" ou "non" et "oui" aux 2 questions et cliqué sur le bouton 

"Déclaration mandataires", vous obtenez un écran avec les données de détail pour cette 

année de cotisation: 

 

 

Suivez les étapes ci-après pour importer les données de détail concernant les 

mandataires publics. 

Etape 1: Cliquez sur le bouton "Importer déclaration". 

Attention! Tenez compte que les données importées effacent complètement les 

données existantes. 

Manuel accompagnant l’application protégée PMP-online 49



Suivez maintenant les étapes 2 à 4 décrites plus haut sous Import lors de la saisie d'une 

nouvelle déclaration pour une année de cotisation. 
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Conventions pour la création d'un fichier d'importation 

Afin de pouvoir importer vos données déclaratives, elles doivent être préparées dans un 

format déterminé. Cela veut dire que vous devez créer un fichier CSV en MS Excel. 

Créer un fichier CSV en MS Excel au départ d'une nouvelle 
feuille de calcul 

Si vous n'avez pas encore préparé pour vous-même, sur votre pc, de feuille de calcul en 

MS Excel avec les données détaillées relatives aux mandataires publics, vous pouvez 

créer un fichier CSV en Excel au départ d'une nouvelle feuille de calcul. 

Suivez les étapes ci-dessous pour ce faire. 

Etape 1: Ouvrez votre application MS Excel. 

Etape 2: Définissez sur la première ligne de la feuille de calcul les noms de champ 

(type, nummer, naam, periodeStart, periodeEinde, beloning, instellingNummer, 

instellingNaam) comme indiqué sur l'écran ci-dessous: 
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Etape 3: Formatez les cellules avec les définitions exactes. 

Suivez les étapes ci-dessous pour ce faire. 

Etape 3.1: Positionnez la souris sur la lettre au-dessus de la colonne et cliquez une fois 

sur le bouton gauche de la souris. La colonne "A" qui correspond au nom de champ 

"type" est sélectionnée. 

 

Etape 3.2: Cliquez dans la barre de menu sur Format > Cells. 

 

Etape 3.3: Dans l'onglet "Number", sous "Sample" se trouve le nom du champ, dans ce 

cas-ci "type". Dans l'onglet "Number" sous "Category", cliquez dans ce cas sur "Text" et 

puis sur "OK". 
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Répétez les étapes 3.1 à 3.3 pour chaque colonne. 

Dans le tableau ci-dessous, vous trouverez quel format correspond à quelle colonne: 

Colonne Format 

type Text 

nummer Text 

naam Text 

periodeStart Date 

periodeEinde Date 

beloning Number 

instellingNummer Text 

instellingNaam Text 

 

Etape 4: Complétez à présent sur la feuille de calcul les données détaillées relatives aux 

mandataires publics.  

Vous trouverez plus d'info sur les données de détail relatives aux mandataires publics 

sous Vous avez répondu "oui" à la question 1 et "oui" à la question 2 - A. Champs sur le 

formulaire "Données de détail mandataires". 

Attention! Pour supprimer des lignes, vous devez procéder comme suit: 

 

• Mettez le curseur sur le numéro de ligne à gauche et cliquez sur le bouton 

gauche de la souris. La ligne entière est sélectionnée. 

• Cliquez dans la barre de menu sur Edit > Delete pour supprimer la ligne. 
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Etape 5: Stockez le fichier en CSV. 

 

Le fichier CSV est prêt à être importé. 

Vous trouverez plus d'info sur la fonction d'importation sous Fonction d'importation. 
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Créer un fichier CSV en MS Excel au départ d'une feuille de 
calcul existante 

Lorsque vous avez déjà préparé pour vous-même sur votre pc une feuille de calcul en 

MS Excel avec les données détaillées relatives aux mandataires publics, vous pouvez 

créer un fichier CSV en Excel au départ d'une feuille de calcul existante. 

Suivez les étapes ci-dessous pour ce faire. 

Etape 1: Ouvrez votre application MS Excel et ouvrez la feuille de calcul que vous avez 

préparé précédemment. 

Etape 2: Il y a 2 possibilités: 

Soit vous indiquez les noms de champs (type, nummer, naam, periodeStart, 

periodeEinde, beloning, instellingNummer, instellingNaam) sur la première ligne de votre 

feuille de calcul comme montré sur l'écran ci-dessous: 

 

Si vous choisissez cette option, vous devez lors de l'importation du fichier dans 

l'application de déclaration, dans le menu "Première ligne du fichier d'importation", 

choisir "Contient des définitions de champs". 

Soit vous veillez à ce que les cellules correspondent avec la structure du fichier 

d'importation. Cela veut dire qu'il n'y a pas de noms de champ sur la première ligne de la 

feuille de calcul, mais immédiatement les données de détail des mandataires publics. 

Lorsque vous choisissez cette option, vous devez lors de l'importation du fichier dans 

l'application de déclaration, dans le menu "Première ligne du fichier d'importation", 

choisir "Comprend les données". 
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Etape 3: Formatez les cellules avec les définitions exactes. 

Suivez les étapes ci-dessous pour ce faire. 

Etape 3.1: Mettez le curseur sur la lettre au-dessus de la colonne et cliquez une fois sur 

le bouton gauche de la souris. La colonne "A" qui correspond au nom de champ "type" 

est sélectionnée. 

 

Etape 3.2: Cliquez dans la barre de menu sur Format > Cells. 

 

Etape 3.3: Dans l'onglet "Number", sous "Sample" se trouve le nom du champ, dans ce 

cas-ci "type". Dans l'onglet "Number", sous "Category", cliquez dans ce cas sur "Text" et 

puis sur "OK". 
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Répétez les étapes 3.1 à 3.3 pour chaque colonne. 

Dans le tableau ci-dessous vous trouvez quel format correspond à quelle colonne: 

Colonne Format 

type Text 

nummer Text 

naam Text 

periodeStart Date 

periodeEinde Date 

beloning Number 

instellingNummer Text 

instellingNaam Text 

 

Attention! Quand vous voulez supprimer des lignes sur la feuille de calcul, vous devez 

procéder comme suit: 

 

• Mettez le curseur sur le numéro de ligne à gauche et cliquez sur le bouton 

gauche de la souris. La ligne entière est sélectionnée. 

• Cliquez dans la barre de menu sur Edit > Delete pour supprimer la ligne. 
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Etape 4: Stockez le fichier en fichier CSV. 

 

Le fichier CSV est prêt à être importé. 

Vous trouverez plus d'info sur la fonction d'importation sous Fonction d'importation. 
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Fonction d'exportation 

La fonction d'exportation vous permet, en tant qu'organisme, d'exporter une déclaration 

ouverte pour une année de cotisation. Cela veut dire que vous pouvez décharger de 

l'application déclaration les données détaillées relatives aux mandataires publics que 

vous avez introduites et les sauvegarder sur le disque dur de votre pc. Ainsi vous 

pouvez les modifier et par exemple les utiliser de nouveau en vue d'une prochaine 

année de cotisation. 

Après avoir cliqué sur "Déclarations ouvertes" à la gauche de l'écran et puis sur l'année 

de cotisation pour laquelle vous voulez exporter les données déclaratives, vous obtenez 

un écran semblable à celui-ci: 
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Suivez les étapes ci-dessous pour exporter les données de détail des mandataires 

publics. 

Etape 1: Cliquez sur le bouton "Exporter déclaration". Vous obtenez un écran semblable 

à celui-ci: 

 

Etape 2: Cliquez sur "Save" pour sauvegarder le fichier .txt avec les données 

déclaratives sur votre pc. 
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Comment adapter et utiliser de nouveau un fichier .txt avec vos données 
déclaratives, par exemple en vue d' une nouvelle déclaration? 

Afin de pouvoir modifier et utiliser de nouveau le fichier .txt avec vos données 

déclaratives, vous pouvez l'importer dans MS Excel. 

Suivez les étapes ci-dessous pour ce faire. 

Etape 1: Ouvrez votre application MS Excel. 

Etape 2: Ouvrez le fichier .txt sur votre disque dur via le menu File > Open. Vous 

obtenez un Text Import Wizard: 

 

Etape 3: Choisissez Delimited (caractère de séparation) et cliquez sur "Next" 

("Suivant"). Vous obtenez l'écran suivant: 
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Etape 4: Choisissez "Semicolon" (l'option virgule) et cliquez sur "Next" ("Suivant"). Vous 

obtenez l'écran suivant: 
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Etape 5: Déterminez par colonne quel est le format de ces champs. Pour ce faire, 

cliquez sur la colonne et indiquez ensuite le format sous "Column data format". 

Dans le tableau ci-dessous vous trouvez quel format correspond à quelle colonne: 

Colonne Format 

type Text 

nummer Text 

naam Text 

periodeStart Date 

periodeEinde Date 

beloning Number 

instellingNummer Text 

instellingNaam Text 

 

Etape 6: Cliquez sur "Finish" ("Terminer"). 

Vous trouverez plus d'info sur la (ré)importation des données détaillées relatives aux 

mandataires publics dans l'application déclaration sous Fonction d'importation. 
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